
 

 

 

 

 

 

 

 

 

 

 



Plug Flow Reactor with Multiple Reactions 

THE PROBLEM STATEMENT 

Allyl chloride is to be produced in a 12-ft. long 2-in ID tube operating at 

isothermal PFR. The feed is a 4:1 molar ratio of propylene to chlorine and 

enters at a feed rate of 0.85 lbmole/hr and 2 atm of pressure and temperature of 

1000 Rankine. The reactor pressure is assumed to be constant.  

             ……………………Reaction1 

             …………………………Reaction2 

The rate constants have units of lbmoles/(hr-ft3-atm2) and are: 

                                   

k
RT

k
RT

1

2

206000
27200

117
6860







*exp( )

. * exp( )                                

where T is in degrees Rankine and R is in Btu/(lbmole ºR). The rate expressions 

are  

                                     

                                     

Calculate 

1) The exiting stream concentrations from the reactor.  

2) Plot the change in concentration of the reactants and products along the 

volume of the reactor. 

 

 

 

 

 

 



Procedure: 

 

Step 1: Creating the flow sheet 

Step 2: Entering the components and formatting engineering units 

Step 3: Entering the feed stream composition 

Step 4: Entering the reactor specs 

Step 5: Running the simulation and retrieving the results 

 

Step 1: Creating the flow sheet 

 

Select and  right click  on the kinetic reactor and choose the kinetic reactor #2 (plug flow 

reactor), feed and product icons on the workspace. Connect the three using the stream. 

Click on the drop down menu that currently says Flowsheet and change it to Simulation. 

 

 
 

 

Step 2: Entering the components and formatting engineering units 

 

Go to the Format menu and click on Engineering Units and select the desired units for 

such properties as R for temperature, and atm for pressure etc. Use English units option 

to convert all units at the same time. Click OK to continue. 



 
 

Go to the Thermophysical on the menu bar and click on Components List. Find 

propylene, chlorine, hydrogen chloride, allylchloride and 1,2-DiCl-Propane  from the 

CHEMCAD component databank and click Add. 

  

 
 

When the Thermodynamic Suggestions window appears, input the desired ranges of 

temperatures and pressures, then click OK. (Also click OK through the next 3 windows 

that pop up.)  



 
 

Step 3: Entering the feed stream composition 

 

Double click on the feed stream and enter the feed information (temperature, pressure, 

total flow rate and component mole fractions) given in the problem statement. Click once 

on Flash to get the feed stream enthalpy and vapor fraction in feed at the feed conditions. 

 

 



Step 4: Entering the reactor specs 

Double click on the reactor. 

 

General Specifications Page: 

 

a. Number of reactions: Since there are two reactions in the given problem, enter ‘2’  

 

b. Reactor Pressure: Enter the reactor pressure as given in the problem statement (2 atm) 

 

c. Pressure Drop: There is no pressure drop in the reactor given in the problem         

statement.  

 

d. Kinetic Rate Expression: There are two options for this. The default option (Standard) 

is used when the rate equation is in standard form. The other option (User Specified) is 

used when the rate law is not in its standard form and the user needs to enter this 

manually. For more information on this, the user can always click on the help button that 

appears at the bottom left corner on this page. For this problem, the kinetic rate 

expression is given, so select the (User Specified) option. 

 

e. Reaction Phase: Since the reactants and products are in vapor phase, click on the vapor 

only option. 

 

f. Specify Reactor Type: As the reactor described in the problem statement is a plug flow 

reactor, PFR should be selected form the drop box. 

 

g. Thermal Mode: As the temperature of the reaction is given at 1000 Rankine, select 

isothermal and imput 1000 in the box next to it. 

 

h. Specify Calculation Mode: As the conversion is to be calculated, Specify Volume, 

Calculate Conversion option should be selected. 

 

i. Reactor Volume: This can be left blank or can be calculated. The volume can be 

specified as a combination of the reactor diameter and length in more specifications. 

 

j. Key Component: The key component is to be specified when we choose the Specify 

conversion, Calculate volume option. So this can be left blank 

 

k. Conversion:  This needs to be left blank, as this is the value that is calculated in the 

simulation. 

 



 
 

Don’t Click OK yet! There is more to complete in the More Specifications page! 

 

More Specifications: 

 

Length of tubes: Enter the Length of the reactor specified in the problem statement (12 ft) 

 

Diameter of tubes: Enter the Length of the reactor (note: convert 2 inches to feet = 

0.1667 ft) 

 

Number of tubes: Enter ‘1’ 

 

# of steps, Stepsize and Tolerance can be left blank as these are optional fields.  

 

Reaction Engineering Units: Change the units so that the units are consistent with the rate 

law (Change time units to minutes 



Temperature reference for heat of reaction: Can be left blank. Chemcad chooses the 

default reference temperature. 

 

Edit reaction number: Can be left blank. 

 

 
 

 

Click OK after completing the specifications page. A new window appears and the 

stoichiometric coefficients for Reaction 1 (The reaction number is displayed on the top 

left hand corner of this window) of all the components are entered in this window as 

shown in the following figures. Also, enter the values in for the activation energy and the 

frequency factor as shown below. Click OK after entering these coefficients. 

 



 
 

Similarly, enter the stoichiometric constants for reaction 2 and click OK. 

 

 



 

As the User Specified option is selected for kinetic rate expression, another window with 

the title User Rate Expressions appears. If a separate Visual Basic code is available, the 

user can browse those files using options available on File path tab. For most practical 

purposes, the user can go directly to the Rxn1 tab or the Rxn2 tab: 

 

 
 

Select the Rxn1 Tab and enter the rate expression for the reaction1. 

 

Name for the Chemical Reaction: Allyl Chloride formation 

 

Variables for User Rate Expressions: CHEMCAD supplies the user with the variables 

described in this section to be used for user rate expressions. 

 

Write User Rate Expression: RxnRate001 = FF * ExpERT * P001 * P002 

 

 

 



 
 

Select the Rxn2 Tab and enter the rate expression for the reaction2. 

 

Name for the Chemical Reaction: 1,2- DiCl-propane formation 

 

Write User Rate Expression: RxnRate001 = FF * ExpERT * P001 * P002 

 

 

 



 
 

Click OK when finished. A window appears to confirm that we allow the cookies from an 

existing excel file so that the Visual Basic program accesses the rate expression specified 

by us. Click on Yes to continue. 

 

Step 5: Running the simulation and retrieving the results: 

 

Now the simulation is ready to be run. Click once on R to run the simulation. 

Alternatively, one can run the simulation by clicking on Run on the menu bar and 

selecting Run all. The status of the simulation can be found at the bottom left hand corner 

of the screen. The message, Run Finished appears in this place if the run is successfully 

completed.  

 

The product stream properties can be found either by double clicking on the product 

stream or by clicking once on Results on the menu, selecting Stream Composition and 

then clicking on All Streams. The results will be available in a WordPad file. 



 
 

To plot the concentrations along the volume of the reactor, Select plot from the toolbar 

and then choose plug flow reactor profile. The following screen will appear.  

 

 



 

Plot Frequency: select a value of ‘1’.  

 

Composition Option: Since we want the compositions in moles choose moles. The 

temperature change along the reactor can also be plotted. Since ours is an isothermal case 

we need not select it.  

 

Select Component to Plot: Select all the components of which we want to see the change 

in concentration. Click OK.   

 

The following graph plots the change in concentration along the reactor volume. 

 

 
 

 

 

 

 

 

 

 

 

 

 

 



 

SHORTCUT COLUMN 
 

Problem Statement: 

 

A 100 kmol/hr stream of ethanol (50 mol%) and n-propanol (50 mol%) is fed to a 

continuous distillation column at room temperature (298 K) and atmospheric pressure. 

The pressure drop across the column is negligible and a reflux ratio of 1.5 is used.  About 

93 mol% of ethanol in feed and 5 mol% of n-propanol in feed is desired to be present in 

the distillate stream.  

 

Design a continuous distillation column to meet the desired specifications using Shortcut 

column in CHEMCAD and report the total number of stages, minimum number of stages, 

feed stage location, minimum and calculated reflux ratios, final distillate and bottom 

stream concentrations and the reboiler and condenser heat duties. 

 

 

Procedure: 

 

Step 1: Creating the flow sheet 

Step 2: Entering the components and engineering units 

Step 3: Entering the composition of feed stream 

Step 4: Entering the shortcut column specs 

Step 5: Running the simulation and retrieving the results 

 

 

Step 1: Creating the flow sheet 

 

Go to new on the File menu and save the blank simulation. Click on Shortcut column on 

the CHEMCAD palette and click once on simulation window to paste it. Click on the 

feed icon on the palette and paste it on the workspace. Similarly, click on the product 

icon and place it on the workspace (do the product twice as there are two product 

streams). After making sure that all the necessary icons are placed on the workspace, they 

can be connected by using stream. CHEMCAD automatically assigns numbers to streams 

and unit operations the order in which they are placed on the workspace. After 

completing the flow sheet, click once in the S/G icon found on the menu bar so that the 

simulation is changed from edit mode to run mode. The same icon can be used to toggle 

between these two simulation modes. Alternatively, one can toggle between Edit 

Flowsheet and Run Simulation on the menu bar to achieve the same. 

 

 

 

 

 

 

 



 

 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Step 2: Entering the components and engineering units 

 

Go to the Thermophysical on the menu bar and click on Components List. Find ethanol 

and n-propanol from the CHEMCAD components list and add them to the component 

list. Go to the Format menu and click on Engineering Units and select the desired units 

for such properties as temperature, pressure etc. Click OK to continue. 

 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Step 3: Entering the composition of feed stream 

 

Double click on the feed stream and enter the feed information (temperature, pressure, 

total flow rate and component mole fractions) given in the problem statement. Click once 

on Flash to get the feed stream enthalpy and vapor fraction in feed at the feed conditions. 

 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Step 4: Entering the Shortcut column specs 

 

Double click on the ShortCut  Column.  

 

1. Select mode: 

The Shortcut column can be used for both design and rating of a distillation column. As 

we need to design a column, option 2 or option 3 can be used for the design mode. Select 

one of these two and continue. 

 

2. Select condenser type: 

As this is not explicitly stated in the problem statement, the condenser can be assumed to 

be total and can be left to this default option. 

 

3. Column pressure: 

As there is negligible pressure drop across the column, one can enter the same pressure as 

that of the feed stream in this field (1 atm). This can also be left blank and CHEMCAD 

sets the pressure to default, which is the pressure of the feed stream. 

 

4. Column pressure drop: 

This can be left blank. 

 

5. Number of stages: 

CHEMCAD calculates the number of stages and stores the calculated number in this box. 

The user needs to leave this box blank. 

 

6. Reflux ratio: 

Enter the value ‘1.5’ in this field. 

 

7. R/Rmin: 

One needs to enter only one of the two specs, reflux rato or R/Rmin. As the reflux ratio is 

specified, this field needs to be left blank. 

 

8. Case study: 

This is optional and can be left blank for our purpose. 

 

9. Key component specifications: 

a. Light key component: Select ‘Ethanol’ 

b. Light key split: Enter ‘0.93’ 

c. Heavy key component: Select ‘n-propanol’ 

d. Heavy key split: Enter ‘0.05’ 

 

10. Calculated results: 

These are the parameters that CHEMCAD calculates and stores the values of. All these 

fields need to be left blank. 

 

Click Ok when finished. 



 

 

 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Step 5: Running the simulation and retrieving the results 

 

After entering the available information on the workspace as described in the previous 

steps, one can run the simulation by clicking on R on the menu bar. Alternatively, one 

can run the simulation by clicking on Run on the menu bar and selecting Run all. The 

simulator indicates the same warnings regarding the estimates as before and one can 

ignore them again and continue with the simulation by clicking on Yes. The status of the 

simulation can be found at the bottom left hand corner of the screen. The message, Run 

Finished appears in this place if the run is successfully completed. To view the product 

stream compositions, one can either double click on the individual product streams or by 

clicking Results on the menu bar and selecting Stream Compositions and further selecting 

All Streams. The results obtained from the latter method will be in a WordPad file.  

 

 

 
 

All the results associated with the shortcut column can be found by clicking on Results 

menu and selecting Unit Op’s and then the shortcut Column. The results will then be 

available in a WordPad file. 

 



 
 

 


